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Legal Notices 
 

Copyright © 2019 Goliath Technologies Inc. All rights reserved. www.goliathtechnologies.com 
 

Goliath Technologies believes the information in this publication is accurate as of its publication date. The 
information is subject to change without notice. 
 

THE INFORMATION IN THIS PUBLICATION IS PROVIDED “AS IS.” GOLIATH TECHNOLOGIES MAKES NO 
REPRESENTATIONS OR WARRANTIES OF ANY KIND WITH RESPECT TO THE INFORMATION IN THIS PUBLICATION, 
AND SPECIFICALLY DISCLAIMS IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. 
 

Use, copying, and distribution of any Goliath Technologies software described in this publication requires an 
applicable software license. 
 

Linux is a registered trademark of Linus Torvalds. 
 

Windows is a registered trademark of Microsoft Corporation. 
 

VMware, ESX, ESXi, vCenter, and vSphere are either trademarks or registered trademarks of VMware Corporation.  

Citrix, Xen, XenServer, and XenCenter are either trademarks or registered trademarks of Citrix Systems Inc.  

All other trademarks and copyrights referred to are the property of their respective owners. 

 

Support, Sales, Renewals and Licensing 
 

▪ For information on new sales, licensing and support renewals you can email 
sales@goliathtechnologies.com 
 

▪ For additional information about Goliath Technologies products and services, go to 
http://www.goliathtechnologies.com  

 
▪ For customers and partners with an active support agreement, the best way to contact us is to 

use the “Submit a Ticket” button at https://support.goliathtechnologies.com for information 
about software patches, technical documentation, and support programs. Feel free to also email 
support@goliathtechnologies.com or call in at 1-855-465-4282 

 
 

Note: A valid support agreement is necessary to receive new release and software updates. 
  

http://www.goliathtechnologies.com/
mailto:sales@goliathtechnologies.com?subject=Sales%20Inquiry
http://www.goliathtechnologies.com/
https://support.goliathtechnologies.com/
mailto:support@goliathtechnologies.com
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Goliath Performance Monitor Prerequisites   
Component Requirement 
Goliath Server • Virtual Machine or Physical Server 

• Windows Server 2012 R2 – 2016 64bit 
o English version of Windows required 

• Static IP address 

• Minimum of 8 vCPU 
• Minimum of 12 GB RAM 

• Minimum of 25 GB Disk Available 

• Internet Explorer 11 installed 

Database • Microsoft SQL Server 2014 – 2017 
o Microsoft SQL Express 2008 R2 is the embedded database option packaged with the product 
o Always On Cluster supported with the Goliath database running in ‘Simple’ mode 

• SQL Server Configuration Recommendations: 
o Enable “Boost SQL Priority” for the SQL Server Processors 
o Set the “Max Server Memory” value as indicated in the below chart 

• SQL Server Sizing Recommendations based on environment size: 
 Small Medium Large Extra Large XXL 

# of Citrix XA/XD and/or 
VMware Horizon Servers, VDI  

Less than 500 Up to 1,500 Up to 3,000 Up to 8,000 Above 8,000 

CPU 4vCPU 6vCPU 8vCPU 16vCPU 

Technical discussion 
required for 

recommendations 

Memory 8 GB RAM 16 GB RAM 32 GB RAM 64 GB RAM 

# of TempDB’s 4 6 8 8 

Max Server Memory (MB) 4860 10300 25500 51245 

Drive space Please consult our Database Estimator document 

Drive Type 
N/A N/A N/A 

SSD drives w/TBs of 
storage 

* The above recommendations are assuming the SQL Server is remote 

Firewall Goliath Server 
• HTTPS 443/TCP 47629 opened inbound and outbound for web console connection 

• TCP 8282* opened inbound for agent connection to agent location 

• TCP 135, 445, 49164 open outbound for remote agent installation via web console 
Goliath Intelligent Agent 

• TCP 8282* opened outbound for agent connection to the Goliath Server 

• TCP 135, 445, 49164 open inbound for remote agent installation via web console 
Hypervisor 

• HTTPS 443 opened outbound for connection to VMware vCenter 

• HTTP 80 opened outbound for connection to Citrix XenServer Pool Master 

• TCP 8282* opened outbound for connection from Microsoft Hyper-V to the Goliath Server 
Epic System Pulse Module 

• HTTPS 443 opened outbound for connection to Epic System Pulse 
* Default ports listed and can be modified. 

Agent 
Specifications 

• Virtual Machine or Physical Server 

• Windows Server 2008 R2 to 2016 

• Windows 7 to 10 

• Unix/Linux & Mac 

• 0.1% CPU of CPU core 

• 1.5 MB on Disk 

• ~ 30 MB RAM on Windows Server, Linux/Unix, Mac 

• ~ 50 MB RAM on Citrix XenDesktop 
• ~ 80 MB RAM on Citrix XenApp  

Supported 
Browsers 

For the best experience we recommend using the latest version of your preferred browser from the list of supported 
browsers below. 

• Chrome v63 and later 

• Firefox v50 and later 

• Internet Explorer v11 

Supported 
Languages 

Goliath Technologies supports user experience monitoring for the following: 

• Citrix Virtual Apps and Desktops (formerly Citrix XenApp & XenDesktop): Windows 7-10 (Desktop), 2008 R2 – 
2016 (Server) with base operating system languages of English, German, French, Danish, Dutch and Spanish. 
 

• VMware Horizon: Windows 7-10 (Desktop), 2008 R2 – 2016 (Server) with base operating system languages 
of English and Spanish. 

  
Language packs are not supported for user experience monitoring on either platform (Citrix/VMware). 
 
 
 
 

https://goliathtechnologies.com/wp-content/uploads/2018/11/GPM-Database-Estimator-Tool.xlsx
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Hypervisor Monitoring 

VMware 
v4.0 to 6.7  

• Service account with Read Only Rights 
 

Citrix XenServer 
v5.5 to 7.6  

• Service account with Read Only Rights 

• NVIDIA GRID K1/ K2 card monitoring supported 

Microsoft Hyper-V  • Windows Server 2008 R2 – 2016 

• Administrator level Credentials to access the Hyper-V Hosts/Servers  
Citrix Virtual Apps and Desktops Monitoring (Citrix XenApp & XenDesktop)  

Citrix Virtual Apps 
and Desktops 
(formally Citrix 
XenApp & 
XenDesktop) 
v6.5 to 7.18, 7 
18xx 
 

• Service Account with Read Only Citrix Admin Rights within Citrix Studio and Local Admin Rights on the 
Delivery Controller required for Citrix 7.X and 7 18xx Inventory & Metric Collection. 

o If you will also be implementing the Application Availability Monitor, Full Citrix Admin Rights within 
Citrix Studio are required. 

o If using Citrix PVS, the above service account must also be a member of the PVS Farm 
Administrator group and have Local Admin Rights on the Provisioning Servers 

• Windows 7-10 (Desktop), 2008 R2 – 2016 (Server) (For foreign language support, Windows installation of English, 
German, French and Spanish is supported.) 

• PowerShell 2.0 or newer required 
• Full Microsoft SQL suggested for full implementations of Goliath Performance Monitor, please consult the 

SQL requirements above 

Citrix XenApp & XenDesktop Monitoring 

Citrix NetScaler 
NetScaler 10.5+ 

 (This is used for Goliath Performance Monitor’s Topology View) 

VMware Horizon Monitoring 

VMware Horizon 
v6.0 to 7.6 

• Service Account with Read Only Admin Rights within the Horizon Admin Console and Local Admin Rights on 

the Connection Server 

• Windows 7-10 (Desktop), 2008 R2 – 2016 (Server) (Only English Windows installations supported.) 

• PowerShell 2.0 required 

• Full Microsoft SQL suggested for full implementations of Goliath Performance Monitor, please consult the 
SQL requirements above 

Epic System Pulse Monitoring 

Epic System Pulse • Service Account with Read-Only Rights 

• HTTPS w/ Username enabled for Outgoing Data Services via Epic System Pulse Configuration Editor 
• HTTPS enabled for Incoming Data Services via Epic System Pulse Configuration Editor 

• Valid Certificate applied to Epic System Pulse and the Goliath Server trusts the Epic System Pulse Server 
Certificate 

Additional Monitoring 

Windows Mobile 
Device/Tablet 

 Windows 8 – 10 

 0.1% CPU 

 1.5 MB on Disk 

 ~ 30 MB RAM 
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Goliath Service Accounts 
Please see the below guidelines for rights needed within Goliath Performance Monitor. One account can be 
created with all rights. 

Infrastructure Component Rights Notes 

Remote SQL Server  DBO Needs to be a domain account and is applied to the 
Goliath Database.  

Goliath Server* Local Admin Rights The account that has DBO rights to the Goliath database 
will also need local admin rights on the Goliath server. 

VMware vCenter Read-only Needs to be defined at the vCenter level, not at 
Datacenter or lower for read-only 

Citrix XenServer Read-only Needs to be defined at the XenServer level, not at 
Datacenter or lower for read-only 

Citrix Virtual Apps and 
Desktops 7.x and 7 18xx** 

Read-only Citrix Admin, 
Local Admin on DDC, PVS 
Farm Admin, Local Admin 
on PVS 

At least read-only admin rights within Citrix Studio and 
local admin rights on the delivery controller. If using PVS, 
this account also needs to be a PVS farm admin. 

VMware Horizon Read-only Horizon Admin, 
Local Admin on 
Connection Server 

At least read-only admin rights within Citrix Studio 
Horizon Admin Console and Local Admin on the 
Connection Server 

Epic System Pulse Read-only At least read-only rights to Epic System Pulse 

*only needed if using an external database 
** If also using the Goliath Application Availability Monitor, Full Citrix Admin Rights are required 

Goliath Firewall Settings 

A. Goliath Intelligent Agent 
(Includes Citrix XenApp/VMware Horizon Servers, Citrix XenDesktop/VMware Horizon VDI’s, Virtual Machines, and 

Workstations) 

Source Destination Port Traffic Notes 
Agent Location Goliath Server TCP 8282 Outbound Agent connection. Default port listed, 

port can be modified. 

Goliath Server Agent Location TCP 135, 
445, 
49164 

Inbound These ports are for the RPC calls used to 
do the remote installation of the agent 
from the Web console.  

Monitoring Endpoints/Workstations that reside outside your network will require the following: 

• NAT policy on the firewall to allow agent communication outbound via TCP 8282 (default port, this can be 
changed) 

• Public IP address of the firewall 
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B. Goliath Server 

C. Goliath Hypervisor Monitoring 
 

Source Destination Port Traffic Notes 
Goliath Server VMware HTTP 443 Outbound VMware connection 

Goliath Server Citrix XenServer  HTTP 80 Outbound Citrix XenServer Connection 

Microsoft Hyper-V Goliath Server TCP 8282 Outbound Agent connection. Default port listed, 
port can be modified. 

Goliath Antivirus Exclusions/Filters 
While not a-typical, we have been exposed to client environments which require antivirus filtering, or exclusion 

rules needing implemented due to the antivirus software conflicting with the Goliath Intelligent Agent. For that 

reasoning, we do recommend implementing exclusion rules which consist of the following: 

• Main Goliath Server  
o Directory Exclusions:  

▪ \Program Files (x86)\MonitorIT\** – This is the install directory of the Goliath Server, the 
local Agent, and relevant files (please include all subfolders/files) 

▪ Ensure recursive exclusions for the subfolders is allowed 
o Process Exclusions:  

▪ RPMAgent.exe – This is the process which is launched by the Agent’s Service 
▪ RPMCCS.exe – This is the process which is launched by the Server’s Service 
▪ AgentService.exe – Process supporting the Agent’s Windows Service 
▪ Java.exe – Supports hypervisor API communication 
▪ MonitorITService.exe - Process supporting the Goliath Server’s Windows Service 
▪ Stunnel.exe – (Optional component) Used to support sending alerts and notifications via 

SSL/TLS enabled mail servers 
Please Note: Directory level exclusions are required on the Goliath Server due to the fact that some 

files are created dynamically in the Goliath application directories.  

• VMs/Servers with Agents on them (Citrix machines, VMs, etc)  
o Directory Exclusions:  

▪ Path: \Program Files\MonitorIT 
▪ Ensure recursive exclusions for the subfolders is allowed 

o Process Exclusions:  
▪ RPMAgent.exe – This is the process which is launched by the Agent’s Service 
▪ AgentService.exe – Process supporting the Agent’s Windows Service 

Source Destination Port Traffic Notes 
Agent Location Goliath Server TCP 8282 Inbound Agent connection. Default port listed, 

port can be modified. 

Goliath Server Agent Location TCP 135, 
445, 49164 

Outbound These ports are for the RPC calls used to 
do the remote installation of the agent 
from the Web console. 

(Anywhere) Goliath Server HTTP 443 Inbound Web console connection. Default port 
listed, port can be modified. 

Goliath Server (Anywhere) HTTP 443 Outbound Web console connection. Default port 
listed, port can be modified. 
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▪ Please Note: File level exclusions should not be combined with Directory exclusions  
o OPTIONAL (if Directory exclusions are not allowed) File Exclusions @ \Program Files\MonitorIT:  

▪ AgentEvents.dll 
▪ AgentService.exe 
▪ Lua5.1.dll 
▪ Mfc90.dll 
▪ mfc90u.dll 
▪ mfc100.dll 
▪ mfcm90.dll 
▪ mfcm90u.dll 
▪ mfcm100.dll 
▪ Microsoft.VC90.CRT.manifest 
▪ Microsoft.VC90.MFC.manifest 

 

▪ MISNMP.dll 
▪ msvcm90.dll 
▪ msvcp90.dll 
▪ msvcp100.dll 
▪ msvcr90.dll 
▪ msvcr100.dll 
▪ PSInterface35.dll 
▪ PSInterface40.dll 
▪ PSInterfaceLink.dll 
▪ RpmAgent.exe 
▪ Uninstall.exe 

 

• Goliath Master Agent:  
o Directory Exclusions:  

▪ Path: \Program Files\MonitorIT 
▪ Ensure recursive exclusions for the subfolders is allowed 

o Process Exclusions:  
▪ RPMAgent.exe – This is the process which is launched by the Agent’s Service 
▪ AgentService.exe – Process supporting the Agent’s Windows Service 
▪ Java.exe – Supports hypervisor API communication 
▪ Please Note: File level exclusions should not be combined with Directory exclusions  

o OPTIONAL (if Directory exclusions are not allowed) File Exclusions @ \Program Files\MonitorIT:  
▪ AgentEvents.dll 
▪ AgentService.exe 
▪ Lua5.1.dll 
▪ Mfc90.dll 
▪ mfc90u.dll 
▪ mfc100.dll 
▪ mfcm90.dll 
▪ mfcm90u.dll 
▪ mfcm100.dll 
▪ Microsoft.VC90.CRT.manifest 
▪ Microsoft.VC90.MFC.manifest 

 

▪ MISNMP.dll 
▪ msvcm90.dll 
▪ msvcp90.dll 
▪ msvcp100.dll 
▪ msvcr90.dll 
▪ msvcr100.dll 
▪ PSInterface35.dll 
▪ PSInterface40.dll 
▪ PSInterfaceLink.dll 
▪ RpmAgent.exe 
▪ Uninstall.exe 
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Deployment Architecture 
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Are You Ready to Install? 
To complete the installation of Goliath Performance Monitor (GPM), please ensure you have the 
following items available and prepared: 

1. Goliath Performance Monitor installation file (gpmserver_setup64.exe) 

2. Your license key (this should have been provided by Goliath Finance Dept) 

3. Static IP applied to the server hosting Goliath Performance Monitor 

4. Confirm the Prerequisites listed above are completed 

Goliath Performance Monitor Server Installation Steps 
The Setup program will install the Goliath Performance Monitor server on the system you want to be 
designated as the Server computer.  

 

1. Exit all programs 
 

2. To install GPM, run the downloaded executable, ‘gpmserver_setup64.exe’ 
 

3. The executable will start the install process and display a Welcome installer 
 

 
 
 
 

4. Click ‘Next’ to view the End User License Agreement.  
Note: It is strongly recommended that you exit all open Windows programs before continuing with 
the installation  

 

5. Read the agreement and if you agree with the terms, select ‘I agree to the terms of this license 
agreement’ and click ‘Next’. If you do not agree or do not wish to continue, select ‘I do not agree to 
the terms of this license agreement’ and click ‘Cancel’ to exit the installer. 
 

6. Enter your product license key provided by Goliath Technologies and select ‘Next’ to continue. 
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7. Please verify and or specify the ‘STATIC IP Address’ or ‘DNS Name’ for the Goliath Performance 
Monitor Server and Web Interface ‘Console Port’. When finished select ‘Next’ to continue. 
 

 
 

8. Once ‘Next’ is selected, the wizard will verify that the Console Port is available. If it is, Goliath 
Performance Monitor will then connect to it. 
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9. The next step lets you select where to install the Goliath Performance Monitor program. When the 

appropriate location is confirmed or entered, click ‘Next’ to continue. 
a. the default location is ‘C:\Program Files (x86)\MonitorIT’.  

 
Note: It is recommended that you use the default location 

 
 

 
 

 

10. If this is a full installation with an official license key, you will see the following options for 
configuring the database settings.  

a. For “Manual Configuration” please see Appendix C for instructions. 
 

 
 

11. Please verify that the following installation settings are correct, if so select ‘Next’ to proceed with the 
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installation or ‘Back’ to make the appropriate modifications.  
 

 
 

12. During the installation process, a progress bar will show the progress of installing the Goliath 
Performance Monitor, as seen in the figure below. You will also see the installation of the SQL 
Express database installation take place if applicable.  
 

 
 
 

Please Note:  At some points during the installation your screen may go blank. This is a normal part of 
the installation process.   
 

13. Once Goliath Performance Monitor and SQL Express, if applicable, are successfully installed the 
install program will display a message that the installation is complete. Click ‘Finish’ to exit the install 
program. 
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15. You have successfully installed Goliath Performance Monitor and can now launch the application.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



15 Goliath Performance Monitor Installation Guide 
Copyright © 2019 Goliath Technologies  
Version 11.7 – April 2019 

 

Monitor Your Environment 
 Now that Goliath Performance Monitor is installed, next you’ll want to configure monitoring. Please see 

the appropriate sections below for configuring your VMware vSphere, Citrix XenServer, Citrix 

XenApp/XenDesktop, VMware Horizon or Epic System Pulse environment(s). When going through the 

product configuration steps, we recommend configuring the relevant hypervisor first, and then Citrix 

XenApp/XenDesktop or VMware Horizon environments to follow.   

Note: In this document, we refer to XenApp as being published applications and desktops and 
XenDesktop as being VDI.  
 
When configuring VMware and XenServer, for the hosts/pools that you choose to monitor Goliath will 
populate the technology with all the machines and storage associated.  
 
When configuring XenApp & XenDesktop, for the sites that you choose to configure Goliath will populate 
the technology with all the sessions hosts and or VDI within the site. 

 

A. VMware vSphere Hypervisor 
This section will walk you through the discovery and configuration process for adding VMware vSphere 
ESX/ESXi and their subsequent virtualized guest machines and storage to your Goliath Performance 
Monitor inventory. 

 
1. From the ‘Configuration Wizard’, select the icon for ‘Virtual Server’ 

 

2. Choose ‘VMware’ and then select the ‘Next’ button  
 

 
 

3. You will be prompted for the connection information on the ‘Provide Credentials’ page. Select 
‘Next’ once completed 
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4. Select the ‘Hosts’ that you wish to add for monitoring and select ‘Next’ 

 
 

5. Select the option ‘Finish’ and then ‘Next’.  Then ‘Finish’ to leave the wizard. Within 3 minutes your 
VMware inventory will populate into the technology. If you would like to add in another vCenter 
environment, select ‘Repeat Virtual’ and then ‘Next’ to repeat the wizard steps  
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B. Citrix XenServer Hypervisor 
This section will walk you through the discovery and configuration process for adding Citrix XenServer 
and their subsequent virtualized guest machines and storage to your Goliath Performance Monitor 
inventory. 

 
1. From the ‘Configuration Wizard’, select the icon for ‘Virtual Server’ 

 

2. Check ‘XenServer’ and then select the ‘Next’ button  

 
 

3. You will be prompted for the connection information on the ‘Provide Credentials’ page. Select 
‘Next’ once completed 

 

 
 

 
 

4. Select the ‘Hosts’ that you wish to add for monitoring and select ‘Next’ 
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5. Select the option ‘Finish’ and then ‘Next’.  Then the button ‘Finish’ to leave the wizard. Within 3 
minutes your XenServer inventory will populate into the technology. If you would like to add in 
another XenServer environment select ‘Repeat Virtual’ and then ‘Next’ to repeat the wizard steps. 

 
Please see Appendix G for configuring Storage and GPU Monitoring on your XenServer hosts. 
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C. Microsoft Hyper-V Hypervisor 
This section will walk you through the configuration process for adding your Microsoft Hyper-V 
environment to the technology. 
 
1. From the ‘Configuration Wizard’, select the icon for ‘Virtual Server’ 

a. If the wizard is not already displayed on the screen, it can be found by clicking the ‘Settings’ link 
in the top right-hand corner of the technology and then choosing the ‘Configuration Wizard’ 
option. 

 

2. Choose ‘Hyper-V’ and then select the ‘Next’ button  

 
 

3. You will be prompted for the connection information on the ‘Provide Credentials’ page. Enter in an 
account that has admin rights to the Hosts and VMs. Please note, this account will only be used for 
one-time authentication and will not be saved in the database. Select ‘Next’ once completed 

 
4. The technology will then prompt you on how you would like to add your Hyper-V environment. The 

‘Manual’ option is suggested if you will just be adding in a few systems. If adding in 4 or more, it is 
suggested to do discovery via ‘Active Directory’. Select the option that makes the most sense for 
your use case and then click ‘Next’  
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5. According to the option you chose, follow the below instructions: 
a. Manual 

i. Click the ‘Add’ button on the side of the pane 
ii. Enter the hostname & IP address for the Host/VM that you’d like to add into the 

technology and then click ‘Apply’ 
iii. Repeat steps i & ii for each Host/VM that you’d like to add. When finished and 

ready to proceed click ‘Next’ 

 
b. Active Directory 

i. The technology will connect to your Active Directory and discover all of the OUs. 
Navigate through the list and select all of the machines that you would like to 
add into the technology. When finished, click ‘Next’ 

 
6. The technology will then use the credentials provided earlier to install the agent onto the 

specified machines. When the installation is complete, click ‘Next’ 
If you are finished configuring monitoring, click ‘Finish’. Otherwise, if you would like to add in additional Hyper-V 

Hosts/VMs or configure XenServer, VMware or XenApp & XenDesktop monitoring, click the button ‘Configure 

More’ to return to the beginning of the wizard. 
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D. Citrix XenApp and XenDesktop 7.X 
These steps will take you through the configuration process to begin monitoring Citrix XenApp & 

XenDesktop to automatically collect Delivery Group Inventory, User Session Data, and enable Citrix session 

monitoring. The wizard will also assemble the Network Topology view which will take about 5-10 minutes 

to create upon completion of the wizard. 

1. From the ‘Configuration Wizard’, select the icon for ‘XenApp & XenDesktop’ 
2. Select ‘Citrix XenApp’ or ‘Citrix XenDesktop’ as appropriate and then select the ‘Next’ button  

 
 

3. You will be prompted for the connection information on the ‘Add your Citrix Delivery Controllers, 
Storefronts & NetScaler’s’ page 
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4. Click the ‘Add’ button on the right-hand side and complete the requested information for the 

Delivery Controller: 

• Enter the Hostname of one of your delivery controllers and then the IP address 

• Click the drop-down menu in the ‘Role’ field and choose ‘Delivery Controller’ 

• Provide admin credentials in the form of ‘domain\user’. These credentials will be used 
for one-time authentication to install the Goliath Agent 

• An account with Citrix Admin Rights within Citrix Studio is required for metric collection 
on an ongoing basis. If the account you would like to use is the same as the above 
account click ‘Apply’. If you would like to use a separate account uncheck the box for 
‘Also Use…’ and enter the appropriate credentials. When finished click ‘Apply’ 

• If you have more than one Citrix Site that you would like to monitor please repeat this 
step to add the other delivery controller. Goliath will automatically identify your 
remaining site delivery controllers. 

 
 

5. Click the ‘Add’ button on the right-hand side and complete the requested information for a 
Storefront Server: 

• Enter the Hostname of one of your storefront/web interface servers and then the IP 
address 

• Click the drop-down menu in the ‘Role’ field and choose ‘Storefront’ 

• Enter the hostname for one of the Citrix Site Delivery Controllers connected to this 
storefront. 

• Provide admin credentials in the form of ‘domain\user’. These credentials will be used 
for one-time authentication to install the Goliath Agent 

• If you have more than one Citrix Site that you would like to monitor please repeat this 
step to add the other storefronts. Goliath will automatically identify your remaining 
site storefront servers. 
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6. Click the ‘Add’ button on the right-hand side and complete the requested information for a 

NetScaler: 

• Enter the Hostname of one of your NetScaler gateways and then the IP address 

• Click the drop-down menu in the ‘Role’ field and choose ‘NetScaler’ 

• Enter the hostname for one of the Citrix Site Delivery Controllers connected to this 
NetScaler. 

• Please note, this is an agentless configuration used for ICMP monitoring and is not 
dependent on Citrix Session monitoring  

 
 

7. If you would like to add in other role servers like domain controllers, license servers, SQL Servers, 
PVS servers etc. (which is recommended for optimal data in the Topology view) click the ‘Add’ 
button on the right-hand side and complete the requested information: 

• Enter the Hostname of one of the role server and then the IP address 

• Click the drop-down menu in the ‘Role’ field and choose ‘Other Role Server’ 

• Provide admin credentials in the form of ‘domain\user’. These credentials will be used 
for one-time authentication to install the Goliath Agent 

• Repeat the above until all role servers are added 
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8. When all machines have been added, click the ‘Next’ button to continue. The Goliath Agent will now 
be deployed to the Delivery Controller, Storefront Server and any other role server defined. When 
deployment is finished click the ‘Next’ button. 

 
 

 
 

6. The Save and Finish screen will now appear, select ‘Finish’ to close the configuration wizard and 
enter the technology. 

 

Please Note: Upon completing this section, please allow 3-5 minutes for your session hosts/VDI 
machines to auto-populate into the technology and the current sessions that have been established in 
the environment. The Network Topology view will take about 5-10 minutes to render based on the size 
of the environment. 
 
To see examples of what a correct deployment looks like, please see Appendix A. 

 
 
 
 
 
 
 
 
 
 



25 Goliath Performance Monitor Installation Guide 
Copyright © 2019 Goliath Technologies  
Version 11.7 – April 2019 

 

E. VMware Horizon 
These steps will take you through the configuration process to begin monitoring your VMware Horizon 

environment(s). Please note, these instructions are dependent on Section A for VMware vSphere 

Hypervisor being completed. If you have not yet completed Section A, please do so before proceeding.  

1. Navigate to the ‘Configure’ tab and then the ‘Inventory’ submenu. 

2. At the bottom of the page, click the ‘Manage Agents’ button. 

3. Select the VMware Horizon VDI, RDSH servers, and the connection servers in which you’d like to 

install the agent on. 

4. Once selected, click the ‘Deployment Settings’ button and enter administrative credentials 

(domain\user) in order to access the server to install the agent. Click ‘Ok’ when ready. 

5. Click the ‘Install/Update Agents’ bottom at the bottom of the screen. 

6. Depending on the number of agents that are being installed or updated, the process may take 

about 2-10 minutes to complete. You will be prompted when the installation/update is 

complete. 

7. Once the installation is complete, click the ‘Close’ button to return to the Inventory page. Here, you 

can confirm the agents are connecting in by confirming that there is a green box in the ‘Stat’ 

column for that machine. Please note, you may need to refresh the screen after a few minutes in 

order to see page updates. 

8. Once all of the agents are connected, select the VMware Horizon Connection Server and click ‘Edit’ 

at the bottom of the page 

9. A new pane will appear, there will be a section labeled ‘VMware Horizon View Monitoring’ in this 

section please do the following: 

a. In the ‘User Name’ and ‘Password’ fields, please enter the credentials for the Read Only 

Admin Service account for VMware Horizon in the format of “domain\user” 

b. Check the box for ‘Enable Application/Desktop and VDI Monitoring’ 

 
10. Once all information is filled in, click the ‘Save’ button to complete the configuration 

11. Now that the authentication information is saved, you’ll need to update the agent on the 

connection server in order for the API Modules to be installed 

a. At the bottom of the page, click the ‘Manage Agents’ button. 

b. Select the VMware Horizon Connection Servers in which you enable the integration on 

in step 9.  

c. Click the ‘Install/Update Agents’ bottom at the bottom of the screen. 

d. The agent update process may take about 2-4 minutes to complete. You will be 

prompted when the installation/update is complete. 

e. Once the installation is complete, click the ‘Close’ button to return to the Inventory page.  

12. Once the new agent is deployed to the Connection Server the API Modules will begin to enable 

Horizon Monitoring 

a. It may take about 5 minutes or so before the data will appear. Please see the “Product 

Overview” section for details on how to view the VMware Horizon session data. 
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F. Epic System Pulse Module 
These steps will take you through the configuration process to begin monitoring your VMware Horizon 

environment(s). 

1. Click on the ‘Configure’ menu option at the top of the page, and select the ‘Inventory’ submenu 

option 

2. On the ‘Inventory’ page, find and select the line item for the local Goliath Server 

3. Click on the ‘edit’ button at the bottom of the page 

4. A new pane will appear, there will be a section labeled ‘Epic EHR Monitoring’ in this section please 

do the following: 

a. In the ‘User Name’ and ‘Password’ fields, please enter the credentials for the Read Only 

Service account for Epic System pulse in the format of “domain\user” 

b. Check the box for ‘Enable Epic Monitoring’ 

c. In the ‘Epic Server Address’ field, please enter the IP Address or FQDN of the Epic System 

Pulse machine 

d. In the ‘Epic Production Resource Group’ field, please enter the name of the Epic resource 

group. 

 
5. Once all information is filled in, click the ‘Save’ button to complete the configuration 

a. It may take about 5 minutes or so before the data will appear. Please see the “Product 

Overview” section for details on how to view the Epic System Pulse data.  
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Deploy Agents 
This section with provide instructions on how to deploy the Goliath Intelligent Agent to your VMware, XenServer, 

Hyper-V, Citrix XenApp/XenDesktop Environment. Please see the section that is applicable to your environment.  

Note: The Goliath Intelligent Agent is required to collect the following metrics from your Windows 
machines: 

• Event logs 

• Processes 

• Services 

• Performance Counters & Utilization trends 

• File/folder level analysis 
 
In addition to the above, the Goliath Intelligent Agent is required to collect the following metrics from 
your Citrix Session Hosts/VDI: 

• End User Experience Metrics (network latency, ICA RTT, Connection Speed, etc.) 

• ICA/HDX Latency 

• Logon Duration 
 

In addition to the above, the Goliath Intelligent Agent is required to collect the following metrics from 
your VMware Horizon Hosts/VDI: 

• End User Experience Metrics (network latency, ICA RTT, Connection Speed, etc.) 

• Logon Duration 
 

There is no reboot required when installing or updating the agent 

 

A. Automated Agent Installation/Update via the Goliath Console 
Below are instructions for installing the Intelligent Agent install/update on Windows 2008 R2 or newer and 

Windows 7 and newer machines from the Goliath console. This section is recommended for statically built 

machines, if your machines are created via Gold Image, Master Image or VM Template please see the 

appropriate section below. 

1. Open Goliath Performance Monitor and select the ‘Configure’ tab and then the ‘Inventory’ 

submenu. 

2. At the bottom of the page, click the ‘Manage Agents’ button. 

3. If this is the first time an agent is being installed to a server, select the ‘Deployment Settings’ 

button and enter administrative credentials (domain\user) in order to access the server. If you 

are updating an agent that is connected to the product already, please proceed to the next 

step. 

4. Select the server(s)/machines(s) that you would like to install/update the agent on and click the 

‘Install/Update Agents’ bottom at the bottom of the screen. 

5. Depending on the number of agents that are being installed or updated, the process may take 

about 2-10 minutes to complete. You will be prompted when the installation/update is 

complete. 

6. Once the installation is complete, click the ‘Close’ button to return to the Inventory page. Here, 

you can confirm the agents are connecting in by confirming that there is a green box in the ‘stat’ 
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column for that machine. Please note, you may need to refresh the screen after a few minutes. 

 

 

B. Gold Image, Master Image or VM Template Agent Installation 
This section will guide you through the process of installing or updating the Goliath Intelligent Agent in your 

Gold Image, Master Image or Template for Windows 2008 R2 or newer, and Windows 7 and newer. For 

evaluation purposes, if the image/template is not able to be modified please skip this section follow the 

directions in the next section for Auto-Agent Deployment. 

1. Launch the Goliath Intelligent Agent setup installer (InstallAgent.exe) and click ‘Next’ 

a) This can be copied to the image from the goliath server at “C:\Program Files 

(x86)\MonitorIT\Agent\Windows” 

2. Enter the IP Address or FQDN of the Goliath Server.  

3. Enter the Goliath Agent Port used for communication and click ‘Next’. The default agent port is 

8282. 

4. The installer will ask whether the machine where the installer is currently running is a Gold 

Image, Master Image or Template. Select the radio button for ‘Yes’ and then click ‘Next’ 

5. Confirm the agent install directory and click ‘Next’. This should remain “C:\Program 

Files\MonitorIT” unless there is no C drive. If using Citrix PVS, DO NOT INSTALL TO THE WRITE 

CACHE DRIVE. 

6. Confirm the installation setting then click ‘Next’ to start the installation. 

7. After 1-2 minutes the installation will complete, click ‘Finish’. 

a) Please note, once selecting finish it may take a minute for the installer window to close. 

8. No additional steps are required to be added to your normal closing process for the agent. 

Follow your normal process for provisioning the Image or Template.  

 

 

 

Appendix 

A. Full Deployment Examples 

I. XenApp/XenDesktop Sessions 

There are few screens that will indicate that the Citrix API has been enabled and is working: 

Configure>Inventory 

 



29 Goliath Performance Monitor Installation Guide 
Copyright © 2019 Goliath Technologies  
Version 11.7 – April 2019 

 

View>XenApp/XenDesktop Sessions (App Servers & Published Apps/Desktops) 

 

View>XenApp/XenDesktop Sessions (Virtual Desktops) 

 

II. Topology View 

Monitor>Topology 

 

 

III. VMware Horizon 

There are few screens that will indicate that the VMware Horizon API has been enabled and is 

working. 

View>VMware Horizon 
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IV. Epic System Pulse Module 

There are 2 dashboards that will be populated if the Epic System Pulse Module is fully configured.  
 
Navigate to the View>Dashboards page and open the dashboards in the ‘Epic’ Folder 

 

  

 The two dashboards related to monitoring Epic Workflow & Activity will appear and look like this: 
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B. Connecting to a Remote SQL Server 
In this section, we will review the procedure for connecting to a Remote SQL Server Instance from the 
Installer. See the following link to download the Goliath database file: 
https://s3.amazonaws.com/goliathpm/Consulting/Database.zip  

 

1. Download the database file onto the remote SQL Server and place it in the ‘DATA’ Directory 
2. Open SQL Management Studio and connect to the SQL Server 
3. Attach the ‘MonitorIT’ database 
4. Once the attachment is complete, define an account that has DBO rights to the database. This 

account will be needed shortly. 
5. Log onto the server where you will be install Goliath 
6. Confirm that the DBO account for the database has local admin rights on the Goliath Server. 
7. Exit all programs 
8. To install GPM, run the downloaded executable ‘gpmserver_setup64.exe’ 
9. The executable will start the install process and display a Welcome installer 

 
 

 

10. Click ‘Next’ to view the End User License Agreement. Read the agreement and if you agree with 
the terms, select ‘I agree to the terms of this license agreement’ and click ‘Next’. If you do not 
agree or do not wish to continue, click ‘Cancel’ to exit the installer. 

 

11. Enter your Goliath license key provided by Goliath Technologies and select ‘Next’ to continue. If 
you keep the default key of ‘EVAL’ the technology will install using SQL Express. 
 

 

https://s3.amazonaws.com/goliathpm/Consulting/Database.zip
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12. Please verify and or specify the ‘STATIC IP Address’ or ‘DNS Name’ for the Goliath Performance 
Monitor Server and Web Interface ‘Console Port’. When finished select ‘Next’ to continue. 
 

 
 

13. Once ‘Next’ is selected, the wizard will verify that the Console Port is available. If it is, Goliath 
Performance Monitor will then connect to it. 

 

 
 
 
 
 
 
 

 
 
 
 

14. The next step lets you select where to install the Goliath Performance Monitor program. When 
the appropriate location is confirmed or entered, click ‘Next’ to continue. 

a. On 64-bit versions of Windows, the default location is ‘C:\Program Files 
(x86)\MonitorIT’ 
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15. You will see the following options for configuring the database settings. Please select ‘Manual 
Configuration’ and Click ‘Next’ 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

16. Please verify that the following installation settings are correct, if so select ‘Next’ to start the 
installation or ‘Back’ to make the appropriate modifications.  
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17. During the installation process, a progress bar will show the progress of installing the Goliath 
Performance Monitor, as seen in the figure below. Please Note: At some points during the 
installation your screen may go blank. This is a normal part of the installation process.   

 
 

18. Once Goliath Performance Monitor is successfully installed the installer will display a message 
that the installation is complete. Click ‘Finish’ to exit the install program. 
 
 

 
 

20. You have successfully installed Goliath Performance Monitor can click ‘Finish’ 

21. Open the Run window and type ‘C:\Windows\SysWOW64\odbcad32’ 
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22. Once open, go to the System DSN tab 
23. Click ‘Add’ and scroll through the list to select the driver type ‘SQL Server’ or ‘SQL Server Native 

Client’ 

 

24. Name the connection with the information listed below, when finished click ‘Next’ 

a. Define the Name as ‘BreakoutRPM’ 
 

b. Define Description as ‘Primary GPM Database’ 
 

c. For ‘Server’ use the dropdown menu to pick the appropriate server name 
 

 
 

Note: For the SQL Server, be sure to pick the choice with the name in the correct format of the 
server name/instance name of the new database from the dropdown menu. 
 
25. Keep the default settings to use the Integrated Windows authentication to connect to the 

database and select ‘Next’ 
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26. Check the box next to ‘Change the default database to’ and select ‘GoliathDB’ from the 
dropdown menu.  Click ‘Next’ 

        

 
 

 

27. Keep the defaults for the additional options and click ‘Finish 
 
 

28. Select the ‘Test Data Source’ button to validate the connection. Click ‘OK’ to close all 
windows. 

29. Navigate to C:\Program Files (x86)\MonitorIT\Bin 
30. Run ‘MonitorITCFU’ as administrator 
31. Once MonitorITCFU is open fill in the below information: 

a. Root Directory: this is the install directory for Goliath, the default location is C:\Program 
Files (x86)\MonitorIT 

b. Server IP Addr: this is the IP address of the Goliath Server 
c. Web Port: update to 47629 
d. Agent Port: update to 8282 

 
 

32. File>Save as the file with the below information: 
a. Filename: Default 
b. Save as file type: Monitor IT Server Config files (*.btc) 
c. Save File Location: C:\Program Files (x86)\MonitorIT\Bin 
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33. Once it is saved, you can close the program. 
34. Right click the ‘Goliath Performance Monitor’ desktop icon and run the technology ‘as 

administrator’ 
a. The technology will error our, this is normal 

35. Close the product 
36. Open Windows Services 
37. Stop the MonitorIT Server Service 
38. Right click the service to open the properties 
39. Click the ‘Log On’ tab 
40. Specify the DBO account credentials 
41. Click ‘Apply’ and then ‘OK’ to close the window 
42.   Go to C:\Program Files (x86)\MonitorIT\Bin and Run RPMCCS.exe as admin 

a. The product will probably error again, this is normal wait about 3 mins and 
refresh the browser 

 

C. Configuring the Inventory Filter 
This feature of Goliath allows one to filter in or out particular elements from their VMware, XenServer and 

Citrix environment. With our API integrations, Goliath is able to populate the entire inventory, but due to 

the size of your environment, you may not want to see and monitor all components. In this section, I will 

explain how to use the inventory filter. 

 

Inventory Filtering from the ‘First Time Run Wizard’ 

The INCLUDE section: Select a Server or Group TYPE from the dropdown list. Then type a comma-delimited 

list of Server or Group names you want included in Inventory. All other Servers or Groups not listed for the 

selected TYPE are ignored. Start each Inventory specification on a new line. Multiple entries of the same or 

different TYPE allowed. The wild-card, asterisk character, '*', is accepted as the first or last character in a 

name.  
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The EXCLUDE section: Select a Server or Group TYPE from the dropdown list. Then type a comma-delimited 

list of Server or Group names you want excluded from Inventory. All other Servers or Groups not listed for 

the selected TYPE are included in inventory. Start each Inventory specification on a new line. Multiple 

entries of the same or different TYPE allowed. The wild-card, asterisk character, '*', is accepted as the first 

or last character in a name.  

Inventory Filtering from the ‘Inventory’ Screen 

The INCLUDE section: Select a Server or Group TYPE from the dropdown list. Then type a comma-delimited 

list of Server or Group names you want included in Inventory. All other Servers or Groups not listed for the 

selected TYPE are ignored. Start each Inventory specification on a new line. Multiple entries of the same or 

different TYPE allowed. The wild-card, asterisk character, '*', is accepted as the first or last character in a 

name.  

The EXCLUDE section: Select a Server or Group TYPE from the dropdown list. Then type a comma-delimited 

list of Server or Group names you want excluded from Inventory. All other Servers or Groups not listed for 

the selected TYPE are included in inventory. Start each Inventory specification on a new line. Multiple 

entries of the same or different TYPE allowed. The wild-card, asterisk character, '*', is accepted as the first 

or last character in a name.  

• Once the list of items you’d like to include/exclude are complete, select ok  

• Find the items in inventory that you’ve chosen to exclude or are items that you 

haven’t chosen to include and delete them from inventory 

 

D. Configuring Citrix XenServer Storage & GPU Monitoring 

I. Enable Citrix XenServer Storage Monitoring 

In order to start collecting information on your host and VM storage, please make sure the 

following is enabled. 

1. Log into Citrix XenCenter 

2. Select a host where you want to enable/confirm storage metric collection 

3. Click the ‘Performance’ tab 

 

4. Select ‘Actions’ and then ‘New Graph’ 

5. Name the graph ‘Storage Performance’, sort the list by type (Z->A), and select all 

datasources with a type of ‘Storage’ 
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6. When finished, select ‘Save’ 

7. Repeat these steps for all of the hosts that you will be monitoring in Goliath Performance 

Monitor 

II. Enable Citrix XenServer NVIDIA Grid Monitoring 

In order to start collecting information on your host and VM storage, please make sure the 

following is enabled. 

1. Log into Citrix XenCenter 

2. Select a host where you want to enable/confirm NVIDIA Grid metric collection 

3. Click the ‘Performance’ tab 

 

4. Select ‘Actions’ and then ‘New Graph’ 

5. Name the graph ‘NVIDIA Performance’, sort the list by type (A->Z), and select all 

datasources with a type of ‘GPU’ 

 

6. When finished, select ‘Save’ 

7. Repeat these steps for all of the hosts that you will be monitoring in Goliath Performance 

Monitor 


	Goliath Performance Monitor Prerequisites
	Goliath Service Accounts
	Goliath Firewall Settings
	A. Goliath Intelligent Agent
	B. Goliath Server
	C. Goliath Hypervisor Monitoring

	Goliath Antivirus Exclusions/Filters
	Deployment Architecture
	Are You Ready to Install?
	Goliath Performance Monitor Server Installation Steps
	Monitor Your Environment
	A. VMware vSphere Hypervisor
	B. Citrix XenServer Hypervisor
	C. Microsoft Hyper-V Hypervisor
	D. Citrix XenApp and XenDesktop 7.X
	E. VMware Horizon
	F. Epic System Pulse Module

	Deploy Agents
	A. Automated Agent Installation/Update via the Goliath Console
	B. Gold Image, Master Image or VM Template Agent Installation

	Appendix
	A. Full Deployment Examples
	I. XenApp/XenDesktop Sessions
	II. Topology View
	III. VMware Horizon
	IV. Epic System Pulse Module

	B. Connecting to a Remote SQL Server
	C. Configuring the Inventory Filter
	D. Configuring Citrix XenServer Storage & GPU Monitoring
	I. Enable Citrix XenServer Storage Monitoring
	II. Enable Citrix XenServer NVIDIA Grid Monitoring



